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About This Guide

This guide is intended for Ximian Red Carpet users. It contains the following sections:

“Introduction” on page 9

“Software Requirements” on page 10

“Getting Started” on page 10

“Five Ways of Looking at Software” on page 11

“Red Carpet Express: More Software, Faster” on page 14

“Ximian Red Carpet Preferences” on page 15

“Using Red Carpet with Remote Systems” on page 17

“Notes” on page 17

Documentation Updates

For the most recent version of the Ximian Red Carpet Administration Guide see the Ximian Red 
Carpet Documentation Web Site. [ULink]

Documentation Conventions

In this documentation, a greater-than symbol (>) is used to separate actions within a step and items 
within a cross-reference path.

A trademark symbol (®, TM, etc.) denotes a Novell trademark. An asterisk (*) denotes a third-party 
trademark.

When a single pathname can be written with a backslash for some platforms or a forward slash for 
other platforms, the pathname is presented with a backslash. Users of platforms that require a 
forward slash, such as UNIX, should use forward slashes as required by your software. 
About This Guide 7
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1 Ximian Red Carpet

Ximian® Red CarpetTM is a program designed to help you manage the software you have on your 
computer. It can help you install, update, and remove programs, without making you keep track of 
dependencies and conicts yourself. It works with the package management structures your 
operating systems already has, so you can use it alongside unrelated command-line tools.

Introduction 
Red Carpet 2 has a number of important differences from the previous version. The appearance 
and interface have been completely overhauled, and there are several new features like enhanced 
search tools and the ability to make a list of removals and installations, then then do everything at 
once.

One important structural difference is that, as of version 2.0, Red Carpet the graphical tool is 
actually a client for rcd, the Red Carpet Daemon. Having two pieces means: 

You can update remote systems that are running the daemon. Select File >   Connect to choose 
a remote host.

You have a choice between the graphical red-carpet program and the command line rug tools. 
Both tools require the rcd package. Detailed information about rug and rcd are available in 
their man pages (standard UNIX manuals). You can read them by typing man rug or man 
rcd at the command line.

What Is a Package
Software for most versions of Linux is shipped as a package file, most commonly the rpm or deb 
format. Each package contains a set of files that constitute the software itself, plus additional 
information about what the software is, what requirements it has, and where it should be installed. 
Proper packaging makes software easier to install, upgrade, or remove, and can help manage the 
interdependencies among various programs.

Ximian Red Carpet supports the rpm (Red Hat Package Manager, used by most distributions), and 
the deb (Debian) package formats.

What Are Channels and Sections?
Ximian Red Carpet groups software into channels. For example, "Red Hat 8.0," "Ximian 
Evolution Beta Snapshots," and "Ximian Desktop" are all channels. You can subscribe to channels 
that interest you, and ignore those that do not. Ximian Red Carpet will not install or update 
software from channels to which you are not installed.

To subscribe to a channel, select Edit > Channel Subscriptions or click the Channels button in the 
toolbar. A window will open to show you the list of available channels. Check the box next to a 
channel to subscribe.
Ximian Red Carpet 9
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Some channels also have groupings called sections, which describe the purpose of the individual 
pieces of software. "Imaging," "Productivity," and "Development" are examples of sections.

Ximian Red Carpet also gives you access to two important services from Ximian, Inc. 

The rst service, Red Carpet Express, is for individuals, and offers access to special high-speed 
servers with faster connections, so you get better download rates. The other service, Ximian Red 
Carpet Enterprise, is aimed at businesses and workgroups that want to manage software 
deployment on a larger scale.

To find out more about using Red Carpet Express, read the Section called Red Carpet Express: 
More Software, Faster. For more about Red Carpet Enterprise visit the Ximian website. 

Software Requirements
Ximian update and installation services require a network connection. If you do not have a 
network connection, you can still use Ximian Red Carpet to remove software or install local 
packages that you already have on disk. To install from a file, select File > Install Local 
Packages. For information on removing software, see the Section called Remove Software on 
My Computer.

To install, update, or remove software, you must enter your system’s root password.If you do 
not have root privileges, you may only view the software installed on your system.

Ximian ships software for a limited number of operating systems. Not all software is available for 
all systems. The official list of supported systems is available at the Ximian Support Center.

Getting Started
To start using Ximian Red Carpet, select System Software Update from the menu panel, or type 
red-carpet at the command line. Enter your root password when prompted.

The Red Carpet window has two major sections that display information. In the center, there is a 
list of software packages. On the left side of the window is a list of transactions. As you use Red 
Carpet, you will choose software from the package list to install or remove, adding the installation 
or removal to the list of actions.

For detailed information about a package, select it and click the Information button.
NOTE: To change the way information is sorted, click the headers at the top of the columns of data. For 
example, to sort software in alphabetical order by package name, click the Package header. Click again to sort 
in reverse alphabetical order.

To select a package, click on it with the left mouse button. You can select multiple packages by 
holding down Ctrl and clicking, or select a range using Shift. To select all packages in the list, press 
Ctrl-A.

To mark a package for installation or removal, click the Mark for Installation or Mark for Removal 
buttons at the bottom of the screen. You can also click the Action column to choose an action for 
each package.

How Many Kinds of Transactions Are There?
There are only two basic kinds of transactions in Red Carpet: installation and removal. An upgrade 
is essentially the removal of the old version and installation of the new one. Therefore, there are 
only two actions you can choose: Mark for Installation and Mark for Removal.
10   Novell Ximian Red Carpet Administration Guide
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Where appropriate, Red Carpet displays upgrades as though they were single transactions. For 
example, the History view has an Action column that displays upgrades as well as installs or 
removals.

To remove an item from the list of pending transactions, select it and click Cancel or right-click on 
it and select Cancel.

When you are done choosing actions, click the Run Now button. Red Carpet will then check to see 
if additional actions are required. For example, if you attempt to install a new spelling dictionary, 
but do not have the spelling tool, you will need to install the the spelling tool as well as the 
dictionary.

Red Carpet will present you with a list of the actions that it is about to take, and ask you to conrm 
or cancel. If you are satised with the set of actions, click Continue.

Use a Mirror for Faster Downloads

For best performance, select a mirror near you. To learn how to choose a mirror, and why mirrors 
can give you a faster download, read the Section called General Preferences.

Five Ways of Looking at Software
Along the top of the right side of the window are five tabs that give you different views of your 
system: 

Updates: This is the view you will see when you start Ximian Red Carpet. It displays updates 
to software that you have installed and that is in channels to which you are subscribed. For 
more information, see “Perform Updates” on page 12.

My Computer: This displays software that is installed on your computer. For more 
information, see “Remove Software on My Computer” on page 13.

Search: This lets you search the largest possible list of packages: those installed on your 
system, and those available for installation in all channels. For more information, see “Search 
for Software” on page 13.

History: This displays a list of actions you have performed in the past. For more information, 
see “View Past Transactions with History” on page 14.

Pending Actions: This displays a detailed list of upcoming software transactions you have 
chosen. To perform them, click the Run Now button in the upper left hand corner of the 
window. For more information, see “The Detailed Transaction View” on page 15.

Perform Updates
When you start Ximian Red Carpet it will show you a list of software packages that you can 
update. An update notice is only shown for software that you already have installed, that is in a 
channel to which you are subscribed, and for which there is a newer version than what you already 
have. New software, and new versions of software that you have but that is in a channel to which 
you do not subscribe, is not part of the update screen.

If you do not see any updates, make sure that you are subscribed to the right channels. See to learn 
how to adjust channel subscriptions.

Each package is displayed with the following information: 
Ximian Red Carpet 11
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To perform a simple update of software that is already on your system:

1 Select one or more packages in the list of available updates.

2 Mark the selected packages for installation by clicking the Mark for Installation 

button.

3 Click the Run Now button to have Ximian Red Carpet perform the updates.

Remove Software on My Computer
To uninstall software that is on your computer now, click the My Computer tab. Red Carpet will 
display a list of the software that is on your system now.

Select packages for removal and click Mark for Removal or click the space next to the package in 
the Action column. When you are nished, click the Run Now button, or select another view to 
choose more transactions.

Each package is displayed with the following information: 

Action: The action you are performing on this package.

Channel: The name of the channel in which this package is shipped.

Package: The name of the package.

Current Version: The version number of the software you have installed now.

There are three ways to change the items in the list:

Channel: Choose from the list of channels to show only the software that comes from a 
particular channel.

Section: Choose from the list of software sections to show only the software of that type. 
Some channels do not use section divisions.

Inforrmation Description

Action The action you are performing for this package. This entry will be blank if you are 
neither installing nor removing it. If you have selected an action, it will have an 
installation or removal icon. You can click on the blank space to perform an action 
(install a package if it is not installed, remove a package if it is installed), or click 
on the icon to cancel the action.

Importance Ximian will indicate how important it is for you to install this update. From 
least to most important, an update can be listed as minor, feature, suggested, 
urgent, or necessary.

Channel The name of the channel in which this package is shipped.

New Version The version number for the updated package. Note that version numbers do 
not count by digits, but instead use numbers separated by. In other words, 
version 1.10 is newer than version 1.9. You can remember this by referring 
to “one point ten” instead of  “one point one zero.”

Current Version The version number of the software you have installed now.
12   Novell Ximian Red Carpet Administration Guide
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Text Search: You can also search for a word or word fragment in the packages and their 
descriptions by typing into the text box above the list of packages.

For this view and for the Search view, you will have the following additional search options:

Search Package Descriptions Check this box to search in package descriptions as well 
as package names.

Any Words or All Words: Select Any Word for a broad search that matches any of the 
words you enter in the text box, or All Words to nd only matches that contain all the words 
you enter.

Substrings or Whole Words: Select Substrings to search for word fragments, or Whole 
Words to search for whole words only. Package names are rarely whole words, so this is 
mostly useful for package descriptions.

Search for Software
To look at the broadest possible range of software, and to nd new software to install, click the 
Search tab. This will not immediately display a list of all available software. You must rst search 
for the software you want to see. If you really wish to see every available piece of software, enter 
a blank search in the search box.

To search for software, select one or more criteria for your search. You can choose:

Channel: Narrow your search to a specic channel. If you do not select anything, you will search 
in all channels to which you are subscribed.

Section: The type of software you are looking for, such as Productivity or Imaging.The default is 
to search in all sections.

Status: You can search for packages that are not installed, packages that are installed, packages 
that you have installed but for which a newer version is available, or for packages of any status. 
The default is to search for packages which you do not have installed.

Text Search: Enter words or word fragments to search for, and press Enter.

The advanced search options are the same as in My Computer. See the Section called Remove 
Software on My Computer for more information.

In the Search view, each package is displayed with the following information:

Action: The action you are performing on this package.

Status: Indicates whether you have the software installed and if so, whether an update is available. 
If you do not have the software, the value is listed as not installed. If you have the same version of 
the software as the one listed, the status will be installed. If you have a different version, the listed 
package will be described as older or newer than the installed version.

Channel: The name of the channel in which this package is shipped.

Lock Icon: The column with the lock icon indicates whether the package is cryptographically 
signed.

Package: The name of the software package.

Version: The version number of the package.
Ximian Red Carpet 13
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View Past Transactions with History
The history view displays a list of of your past transactions. That is, each time you install, remove, 
or upgrade a piece of software, it's recorded here.

The history information is taken from the logs of the Red Carpet Daemon, rcd. It includes 
transactions made with the rug command line tool, but not changes made with dpkg, apt-get, or 
rpm.

It displays the following information about each transaction:

Time: The time and date when the transaction occurred.

Action: Whether you upgraded, installed, or removed the software.

User: The user who performed the action. In most cases, this will be root, but you may allow other 
users to use Red Carpet.

Package: The name of the software package involved in the transaction.

Old Version: For upgrades and removals, this is the version of the software you had installed 
before the transaction. For installs, this entry is blank.

New Version: For Installs and Upgrades, this displays the version of the software after the 
transactions. For removals, this entry is blank.

To change the displayed list, you can choose one or more of the following criteria:

Transaction Type: Normally, the History view shows you all transactions. You may choose 
instead to display just installations, removals, or upgrades.

User: Normally, Red Carpet will show you transactions performed by all permitted users. If you 
have allowed other users to use Red Carpet, you may choose to display just their actions. If you 
have not allowed any other users to change the system, the only option here will be All.

Date Range: Normally, Red Carpet will show you the transactions in the last thirty days. You can 
choose a longer or shorter time frame if you wish.

The Detailed Transaction View
The left side of the main Red Carpet window shows you a list of transactions you have selected, 
but it doesn't have room to give you a lot of detail. For more information about your pending 
transaction list, click the Pending Actions tab.

In addition to the action and package name available in the concise view, the detailed transaction 
view lets you see see the package version number and the amount of disk space taken up by the 
package.

Red Carpet Express: More Software, Faster
Red Carpet Express is a premium service that provides you with exclusive access to high speed 
download servers, plus additional software not available through the free service. Red Carpet 
Express works like basic regular Red Carpet service, except there are more channels of software 
available, and you connect to a dedicated high bandwidth server. A one-year subscription is 
included with the purchase of Ximian Desktop.
14   Novell Ximian Red Carpet Administration Guide
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When you purchase a subscription, you will be given an activation key, which is a string of 
numbers and letters like 83ab2f90e821f000. To activate your subscription, select File > Activate. 
A dialog will open and ask for your email address and the activation code.

You can turn Red Carpet Express and other premium services on or off by selecting Edit > 
Preferences and, under the General section, clicking the Enable Premium Services checkbox.

To sign up for Red Carpet Express, or nd more information about its benets, visit http://
store.ximian.com.

Red Carpet Enterprise
Red Carpet Enterprise allows you to run your own Ximian Red Carpet server and distribute 
software to your network in a secure and convenient manner. Clients may connect with either Red 
Carpet or the rug command line tool, simplifying automated updates. The server includes a web 
interface and scriptable command line tools. You can use Red Carpet Enterprise to manage installs 
and updates for internal or purchased software, plus easy redistribution of software from Ximian, 
SuSE YaST, and the Red Hat Network. For additional information, visit http://ximian.com.

Ximian Red Carpet Preferences
To open the preferences window, select Edit Preferences. The window has four tabbed pages: 
General, Cache, Daemon, and Advanced.

General Preferences
You can set the following preferences here:

Server URL: The location of the Red Carpet server you are using. If you know the exact URL of 
a server, you can enter it here, or choose one from the list of mirrors by clicking the Mirrors button.

Mirrors: Click this button to get a list of mirrors you can choose from. All of these servers have 
the same software as the main Ximian server, and update at least once per day.

For best results, choose a mirror with a physical location near yours. That generally means that 
there are fewer intermediate connections between the server and your computer. In addition, the 
primary Ximian site is often crowded, so even a relatively distant mirror can be faster. Another 
way to get a faster connection is with Red Carpet Express. See the Section called Red Carpet 
Express: More Software, Faster for more information.

Enable Premium Services: If you have already activated Red Carpet Express or Red Carpet 
Enterprise services, you can turn them on and off here.

Require Package Signatures: Ximian ships software with a cryptographic signature. Unless you 
absolutely trust your server (for example, you are using Red Carpet Enterprise) you should leave 
this setting on for security.

Maximum Number of Packages to Download at Once: If possible, Ximian Red Carpet will 
download several packages at once in order to make the best use of your network connection. If 
you have a very fast connection, you may wish to increase this number. If you are sharing your 
connection with others, you may wish to reduce it.

Use a Proxy: If your network uses an HTTP proxy, check this box, then enter the proxy URL. If 
necessary, also enter your username and password. Because Ximian Red Carpet does not depend 
Ximian Red Carpet 15
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on a particular desktop, this setting must be entered independently of the GNOME desktop proxy 
setting.

Download Cache Preferences
Ximian Red Carpet stores downloaded les so that if you quit or cancel an operation, you can 
resume it quickly without downloading again. The Cache tab in the Preferences window lets you 
change cache handling behavior. Your options are:

Cache Downloaded Packages and Metadata: If you don't want to cache anything, uncheck this 
box. It is normally on.

Location of Cached Data: Enter the location where you will save cached files.

Cache Expiration: You can the cache to empty after a certain number of days, or if its contents 
take up more than a certain amount of space. By default, this happens after 30 days or 300 MB. If 
you turn off cache expiration, packages will be kept until you delete them yourself by clicking the 
Empty Cache button.

At the bottom of the window, you can empty the package cache by clicking the Empty Cache 
button.

Advanced Red Carpet Preferences
The options available in this section are:

Dispatcher Host: The dispatcher, or "magic" proxy, is used only in complex Red Carpet 
Enterprise deployments. If you are using one, your system administrator will give you a hostname 
to enter here.

Repackage for Rollback:  When you upgrade or remove software, Ximian Red Carpet normally 
just deletes the old version. However, it is possible to "repackage" it, creating an archived version 
so you can switch back if necessary. Repackaging is time consuming and uses signicant amounts 
of disk space.

Verify Server SSL Certificates with External Authority: This setting demands that the Red 
Carpet server have an identity certicate which is veried by external authority organizations. An 
external certicate is expensive and most servers will not have one.

User HTTP/1.0 for Server Communication: Check this box if your proxy or server insists on 
strict HTTP/1.0 protocol for communications.

Logging Level for rcd-Messages: Operation messages are saved to the le /var/log/rcd/rcd-
messages depending upon the degree of importance assigned to them by the developer. A value of 
1 will send only the messages that are agged as most important; 6 will send every message, and 0 
will send no messages.

Logging Level for Syslog:  Determines the amount of information sent to the central operating 
system log. Messages are sent depending upon the degree of importance assigned to them by the 
developer. A value of 1 will send only the messages that are agged as most important; 6 will send 
every message, and 0 will send no messages.

If you require ner control over the operation of Ximian Red Carpet, you may wish to edit the 
conguration les, as described in the man pages for rug, rcd, and rcd.conf.
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Using Red Carpet with Remote Systems
Ximian Red Carpet may be used with remote systems running the Red Carpet Daemon, rcd. You 
will need to have an account with the daemon on the remote system.

To add an rcd account on the remote system, you must log in to that system as root, and use the 
rug user-add -U username -P password command. Then, you may administer the system without 
logging in as root.

To connect to a remote system, do the following:

1 Select File > Connect.

2 Click the Connect to a remote daemon button.

3 Enter the hostname and, if necessary, port for connection to the remote system.

4 Enter your user name and password.

5 Click the Connect button.

Once you are connected you can view and administer the system as you would a local one, in 
accordance with the privileges granted to your account.

You can also use the rug command to administer a remote system. For information on the 
command line Red Carpet tools, use the man rug command.

Notes
1. gnome-help:fdl http://www.fsf.org 

2. http://ximian.com/products/red_carpet_enterprise 

3. http://support.ximian.com/q?5 

4. http://store.ximian.com 

5. http://ximian.com
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